
Workflow Editor Users Manual 

The workflow editor is used to create a graphical network model of the 
underlying workflow showing the hierarchy and interactions between the individual 
steps in that workflow. In addition, the editor allows you to define parameters 

which describe the details of the various building blocks. 

The building blocks for creating a network are: Workflow, task, subtask, data 

node, raw material, sink, material input port, material output port, material flow 
line, information input socket, information output socket, information flow line, and 
T joint. 

A set of parameters may be associated with the first six building blocks. 

All workflows are stored in your home folder on the HUB as text files with 

.wftcl extension. 

Starting the Workflow Editor 

First log into the appropriate HUB. In the My Tools window of your dashboard 
select the All Tools tab. The available tools are listed alphabetically as shown below. 
Scroll to the bottom of the list and click on the Workflow Editor.  

 

The Workflow Editor will also appear in the Recent tab if it is among top 5 tools you 

use. On the Workflow Editor page click the Launch Tool button.  

Using the Workflow Editor 

The default window of the editor is shown in Figure 1. 



 

Figure 1: The default editor window. 

File Menu 

The File menu has the following options: 

 Clear 
 Load 
 Save 

 Export 

Clear deletes everything on the canvas.   

Load allows to open an existing workflow saved in your workspace. First, a 
file selection dialog box is opened showing the contents of your home folder. 
Typically your workflows will be in your home folder on the HUB. If not, you 

navigate to the desired folder and select a previously saved workflow with the 

extension .wftcl. The editor will display the network on the canvas. 

Save allows you to save the workflow you are currently working on. First, a 

file selection dialog box is opened in your home folder where you will typically save 
your workflows. If not, navigate to the desired folder and save the current workflow 

as a .wftcl file. If you select an existing .wftcl file, it will overwrite the contents 

of that file.  

Export creates a file named export.txt. You can download and save it 

client side. After saving the exported file, you must give it the same name as the 

workflow in it. Thus, if the name of the workflow is mywf, then the name of the 

saved file should be mywf.txt. This file is imported into the Knowledge 

Management System to create a template. 

Add Menu 

A menu of icons is displayed on the left of the drawing canvas, as shown in 

Figure 1. If you hover over an icon, a pop-up box with the meaning and usage of 
that icon is displayed. 

Workflow Icon: 



When you are starting from scratch, the first step is to add a workflow icon 
to the canvas. All the other icons are direct or indirect children of the 

associated workflow.  

To add a workflow to the canvas, drag and drop the workflow icon on the canvas at 

the desired location. A workflow is shown as a cyan rectangle on the canvas, with 
its name in the rectangle.  

Passive Material Input or Output Icon: 

This icon can be added to a subtask.  

To add this icon, drag and drop it on the desired subtask on the canvas. If 

you select a point on or near the left vertical edge of the subtask, it is 
treated as a passive material input to that subtask. If you select a point on or near 
the right vertical edge of the subtask, it is treated as a passive material output from 

that subtask.  

Information Input Icon: 

This icon can be added to a subtask or a data node. 

To add this icon, drag and drop it on the desired subtask or datanode. A 
hollow circle will be added on the left vertical edge of the subtask or the data node.  

Pulling Material Input or Pushing Material Output Icon: 

This icon can be added to a subtask. 

To add this icon, drag and drop it on the desired subtask on the canvas. If 
you select a point on or near the left vertical edge of the subtask, it is treated as a 

pulling material input to that subtask. If you select a point on or near the right 
vertical edge of the subtask, it is treated as a pushing material output from that 
subtask..  

Information Ouput Icon: 

This icon can be added to a subtask or a data node.  

To add this icon, drag and drop it on the desired subtask or datanode. A 
solid circle will be added on the right vertical edge of the subtask or the data node.  

T Icon: 

This icon can be added to a material flow line.  

To add this icon, drag and drop it on the desired material flow line. A square 

with T in it will be placed at the selected location. A T node, allows you to 
add an information flow line to an information input or output icon.  

Closing the Workflow Editor 

To end a workflow editor session, click the Terminate button in the right 
corner of the workflow editor tool (See Figure 1). 

  



Building a Workflow 

A network model of a workflow is constructed by sequentially adding the 
appropriate icons that represent the underlying steps. In addition, you can create 
labels and text fields for the parameters associated with various icons. Thus, the 

workflow building activity consists of two parts, one of creating a graphical network 
of icons, and then specifying the list of parameters associated with each icon.  

The procedure for creating a graphical network is described first, followed by 
the description of steps in creating parameter lists. 

Workflow Icon: 

When you start from scratch, the first step is to add a workflow icon. Click on 
the Workflow icon with the left mouse button, and keeping the button pressed 

locate the icon at the desired location. A cyan rectangle with the default name 
Workflow1 is added to the canvas (Figure 2(a)).  

Workflow/Add Menu: 

If you hover over a workflow icon, the top right corner turns red as shown in 
Figure 2(b). If you hover over the top right corner, a popup box shown in Figure 

2(c) is displayed. If you left-click in that region a menu of choices is displayed as 
shown in Figure 2(d). You can add a Task, a Data Node, a Material Sink, a Material 
Source or a Submit Button icon to a workflow. When you pick the desired menu 

item, the associated icon with a default name is added to the right of the workflow 
icon. You can move the newly added icon to a desired location on the canvas.  

 

Workflow/Edit Menu: 

If you click on a workflow icon, the following menu is displayed. Additionally, 
the flashing dashed lines are displayed around the icon indicating that you are in 

the Edit mode. 

(a) (b) 

(c) 

(d) 

Figure 2: Working with the workflow icon. 



 

 Rename: To change the workflow name, pick this option. An editable text field is 
displayed in the icon. A name can contain only alphanumeric characters. After 

editing the name, hit Enter to complete the renaming operation.  

 Parameter: To define a list of parameters associated with a workflow, select this 

option. See the section on Workflow, Task, Subtask, Material Source Parameters.   

 Delete: To delete the workflow select this option. When you delete a workflow, all 
the associated icons are also deleted. 

Task Icon: 

When you select the Task option of the Workflow/Add menu, a task icon is placed 

next to the workflow icon with a default name (Figure 4(a)).  You can drag the icon 
and place it anywhere on the canvas.  

Task/Add Menu: 

If you hover over a task icon, the top right corner turns red as shown in 
Figure 4(b). If you hover over the top right corner, a popup box shown in Figure 

4(c) is displayed. If you left-click in that region a subtask is added at the end of the 
task as shown in Figure 4(d).  

 

 

Task/Edit Menu: 

The Task/Edit menu is the same as the Workflow/Edit menu shown in Figure 
3 and provides the same functionality. When a task is deleted, all the subtasks of 

that task are also deleted. 

Subtask Icon: 

A subtask can be added only to a task as described above. 

(a) (b) 

(c) 

(d) 

Figure 4: Working with the task icon. 

Figure 3: Edit menu of the Workflow icon. 



Subtask/Edit Menu: 

When you click on a subtask, the subtask Edit menu is displayed. An example 

of the Subtask/Edit menu is shown in Figure 5.  

The Rename, Parameters and Delete options are similar to the Workflow/Edit 

options.  If a subtask has any information ports (input or output) then the 
Information Ports option is enabled, and if it has any material ports (input or 
output) then the Material Ports option is enabled. When a subtask is deleted, all the 

material and information ports associated with the subtask, as well as the material 
and information lines connected to the ports of that subtask are also deleted. 

 

 

Subtask/Edit/Information Ports: 

When you pick the Information Ports option of the Subtask/Edit menu, the 
following dialog box is opened (Figure 6).  

 

The Type, # Connections and Port fields are not editable. You can change the 
default name to a desired name.  

Figure 6: Subtask information ports edit dialog box. 

Figure 5: Edit menu of the Subtask icon. 



To delete a port, check the associated toggle and click the red X button.  

To delete the information flow line connected to a port, check the associated 

toggle and click the button with a plug symbol (denoted disconnected electric plug).  

Subtask/Edit/Material Ports: 

When you pick the Material Ports option of the Subtask/Edit menu, the 
following dialog box is opened (Figure 7).  

 

 

The Type, # Connections and Port fields are not editable. You can change the 
default name to a desired name.  

To delete a port, check the associated toggle and click the red X button.  

To delete the material flow line connected to a port, check the associated 
toggle and click the button with a plug symbol.  

 

Material Flow Line: 

A material flow line connects a passive material input or output (hollow 

triangle) to material pushing output or pulling input (solid triangle), respectively. 
Also, a material line connects a material source to a material pulling input, or a 

material pushing output to a Sink. Before adding a material flow line you must first 
add the appropriate material input and/or output icons to the desired subtask(s) 
(See the section on Add Menu for the steps to add material input and output ports 

to a subtask). 

Suppose you want to connect the output of {Task1,Subtask1} to the input of 

{Task2,Subtask2}. You may start by picking either the output or the input. As you 
hover over the output of {Task1,Subtask1} it turns red as shown in Figure 8(a). 

Figure 7: Subtask material ports edit dialog box. 



 

Pick the output port, and with left mouse button pressed drag the pointer inside the 
{Task2,Subtask2} icon (Figure 8(b)). If there is only one input on the destination 

subtask, then after you release the mouse button a line connecting the ports is 
displayed (Figure 8(c)). If there are multiple ports on the destination subtask, you 
have to first select the port to which the current material flow line is to be 

connected.  

The material flow line models the flow of material between the two end points. A 

material flow line is a solid line. 

Information Flow Line: 

An information flow line connects an information output port to an 

information input port, or an information port (input or output) to a T node. Before 
adding an information flow line, you must first add the appropriate information 

input and/or output icons or a T node.  

Suppose you want to connect the output of {Task1, Subtask1} to the input 
of {Task2, Subtask2}. You may start by picking either the output or the input. As 

you hover over the output of {Task1, Subtask1} it turns red as shown in Figure 
9(a). 

 

(a) 

(b) 

(c) 

Figure 9: Adding an information flow line. 

(a) 
(b) 

(c) 

Figure 8: Adding a matreial flow line. 



Pick the output port, and with left mouse button pressed drag the pointer inside the 
{Task2, Subtask2} icon (Figure 9(b)). If there is only one input on the destination 

subtask, then after you release the mouse button a line connecting the port is 
displayed (Figure 9(c)). If there are multiple ports on the destination subtask, you 

have to first select the port to which the current information flow line is to be 
connected.  

The information flow line models the information exchange between the two end 

points. An information flow line is a dashed line. 

T Node: 

A T node models a sensor or a final control element on a material flow line. A 
T node has three connection points, two are connected to material flow lines while 
one is connected to an information port.  

To add a T node to a material flow line, click on the T icon and drag it over 
the desired material flow line. When the center of the T icon is close to the material 

flow line, it turns red (Figure 10(a)) indicating that you may release the mouse 
button. After you release the button, the material flow line is split and connected to 
the T node. You can move the T icon like other icons. Figure 10(b) shows the 

workflow after adding the T node and moving it to align with the material ports. To 
connect the T node to an information port, pick the desired information port and 

pick the T node as the other end point. Figure 10(c) shows the three connections 
associated with a T node.  

 

(a) (b) 

(c) 

Figure 10: Adding a T connection.  



Workflow, Task, Subtask, Material Source Parameters 

In general, when you select the Parameter option of the Edit Menu of a 

workflow, task or subtask icon, the user defined parameters are displayed in a 
dialog box.  

When you select the Parameter option for a workflow icon for the first time, a 
parameter dialog box, as shown in Figure 11 is opened.  

The parameter Workflow Type is required, and can have value of 

Experimental or Scientific. Although you can delete this parameter, do not delete it. 
If this parameter is not specified, the default type Experimental is added during the 

template creation step. If the workflow type is Scientific, it has fewer internal 
default parameters.  

When you select the Parameter option for a task or subtask icon for the first 

time, an empty parameter dialog box is opened.  

For each user defined parameter there is a row in the Parameter form.  

 

 

 

 

 

Figure 11: Parameter dialog box associated with a workflow icon 

This dialog box allows you to specify a list of ‘User Defined’ parameters with 

the associated icon. When a template is created from the workflow in the KM 
system, a text field is created for each user defined parameter.  

In addition, workflow and task icons have associated with them a set of 

default parameters which are added to the user defined parameter at the time of 
template creation. The default parameters associated with various icons are given 

in Table 1. 

 

 

 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Table 1: Default parameters associated with various icons. 

Icon Default Parameters 

Workflow (Type: Experimental) Purpose 

Location 

Performed by 

Species list 

Phases list 

Comments 

Workflow (Type: Scientific) Purpose 

Performed by 

Comments 

Task Task type 

Performed by 

Equipment 

Subtask Action type 

Action 

Action parameters 

Material Source Specified by 

Amount 

Stream parameters 

    



Parameter form widgets 

+ button: To add a parameter click the + button. An empty row is created at the 

end of the current list. 

Done button: Exit from the form. The current values in the form are stored. 

Exit without saving: Click the x in the top right corner of the dialog box to close the 
dialog box without saving any changes since opening the dialog box. 

Delete a parameter: Click on the toggle associated with the parameter you want to 

delete. A check mark will appear in the toggle. Click the x in red circle to delete the 
selected parameter(s). 

X in top right corner: Exit from the form. Current values in the form are stored. 

Parameter Attributes: 

The following eight attributes are associated with each parameter. 

Name: Click on the default name and enter the desired name. The name string 
becomes the label in the form in the KM system. Typically, name is unique in an 

icons parameter list. 

Type: Select the type from the drop down list. 

Units: Select a measuring unit associated with the parameter’s value. The drop 

down list depends on the type selected. Parameter types and units are given in 
Table 2. 

 

Table 2: Parameter types and associated units. 

amount MassVol 

amtflowrate MassVolMassVolFlowrate 

Datetime String 

density g/l, kg/l, kg/m3, lb/ft3 

Flowrate MassVolFlowrate 

frequency RPM Hz GHz 

length Km m cm mm um nm ft in 

masfr Number 

mass kg g mg um lb 

massflowrate kg/s, kg/h, lb/min 

molfr Number 

number Number 

pressure Pa kPa MPa psig psia atm bar 

selectfromlist EnumListID 

selectwftemplate WfTemplateID 

string String 

surfacetension N/m J/m2 lbf/in 

temperature C K F R 

time s sec ms min hr 



viscosity cP kg/m.s Pa.s N.s/m2 lb/ft.hr lbf.s/in2 

volfr Number 

volume ul m3 ml l ft3 USGal 

volumetricflowrate M3/s ml/min l/s USGal/min ft3/hr 

wftype Experimental Scientific Business 

New parameter types and units can be added to the table by request. 

Value: Default parameter value 

Min: The default minimum value is none.  

Max: The default maximum value is none.  

Group: The default value is 1.  

Index: The default value is internally generated. The parameters are ordered based 

on index. Index must be unique within a set of parameters.  

Saving a Workflow 

To save a workflow, select the Save option of the File menu.  

A file selection box showing the contents of your home folder is opened. You 

will typically save your workflows in the home folder. To store it in a different 
folder, you must first create a folder using the Workspace tool.  

To save the workflow in an existing file, select the appropriate file, for 

example sciwf01.wftcl as show below, and click the Save button.  

 

To save the workflow in a new file, enter the appropriate file name and click 
the Save button.  

Exporting a Workflow 

You export a workflow to create an intermediate file outside of the HUB 

environment. This intermediate file is used to create a template in the KMS. 

The export file is saved on the client, for example your PC, with the name 

export.txt.  

When you select the Export option, the following dialog box is opened. 



  

Click the Save As… button to save the file as export.txt in your default 

download folder. After saving it change its name to the same name as the workflow 
defined in it. You may move it to any desired folder.  

To create a template in the KMS, you select the appropriate export file on the 

client. Typically, the client will be same for using the workflow editor and the KMS. 
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